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[bookmark: _Toc107938102]Unit Record Process Flow
	Process
	Process Name
	Process Description
	Review Log Required?

	Reconcile all awards
	
	
	N/A

	Complete configuration
	Unit Record Report Config
	· Map PeopleSoft Ethnic Group values to URR Ethnicity Categories
· Map PeopleSoft FA Item Types to URR Award Categories (Use worksheet in Appendix A to assist with setup.)
	N/A

	Run State FA Reporting
	Unit Record Report (CTC_URR_AE)
	Generates CSV data file for URR and Reports A and B
	Y

	Review Report C
	
	List of financial aid awards to be included in the URR extract file, but FA Item Types are missing from the Unit Record Report Config setup.
	N/A

	Review Report B
	
	Student error details
Error summary
	N/A

	Review Report A
	
	Student details included in the CSV data extract file
Summary of award totals
	N/A

	Rerun State FA Reporting, as needed once errors are resolved
	Unit Record Report (CTC_URR_AE)
	Generates CSV data file for URR and Reports A and B
	Y

	Submit URR CSV data extract file to WSAC
	WSAC Secure Portal
	
	N/A








[bookmark: _Toc107938103]Unit Record Report Overview 
The Unit Record Report (URR) is a student-specific report of financial aid awarded to resident and nonresident students attending the Washington institutions that participate in the Washington College Grant program. The URR provides comprehensive information on federal, state, private, and institutional financial aid distributed to need-based financial aid recipients. The report also includes information about federal borrowing for non-need based loan recipients.[footnoteRef:1] [1:  Overview, Unit Record Report Manual: 2021-22 Academic Year] 

Unit Record Report Uses
Student-level data with term-by-term program-specific financial aid information is needed by the Council to conduct research; design state financial aid programs that complement other existing federal, state, and institutional programs; describe recipient populations; and administer and evaluate state financial aid programs as required by state law. The URR is the primary data source used by the Council to comply with these statutory requirements.
Data from the URR are used to:
· Provide financial aid data to the Education Research and Data Center (ERDC). These data, in combination with academic and workforce records, may be used by Council staff and other researchers to conduct longitudinal research on the educational and occupational achievements of financial aid recipients.
· Analyze the adequacy of financial aid resources available to financially needy Washington students.
· Describe funding trends and the characteristics of students receiving various types of financial assistance.
· Estimate funding needs and support budget requests for state-funded financial aid programs.
· Estimate the impact of new financial aid programs, changes in program policies, and altered funding levels.
· Contribute to student financial aid policy analysis and program evaluation.
· Respond to legislative requests for information about student financial aid programs available to Washington students. The URR significantly reduces the number of ad hoc data requests of institutions.[footnoteRef:2] [2:  Unit Record Report Uses, Unit Record Report Manual: 2021-22 Academic Year] 





[bookmark: _Toc107938104]Unit Record Report Configuration 
This configuration allows colleges to link the PeopleSoft Ethnic Group value associated with a student’s bio-demo record to the existing Unit Record Report Ethnic Category.  
The Ethnic Group values are pulled from the student’s Ethnicity page in Campus Community.
Navigation: Nav Bar > Navigator > Set Up SACR > Product Related > Financial Aid > CTC Custom > CTC Interfaces > Unit Record Report > Unit Record Report Config > Ethnicity Config tab
Enter the Academic Institution
Select the Search button
If the table is already configured, you can verify, add, and update any of the Ethnic Group values mapped to the Ethnicity Category.
If the table is not configured, select the Add a New Value tab, enter Academic Institution, then select the Add button.
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[bookmark: _Toc107938105]Ethnicity Config tab: 
1. Select the proper Summer Type value – ‘Header’ is for header colleges, ‘Trailer’ is for trailer colleges.
2. Select the appropriate PeopleSoft Ethnic Group for the Unit Record Report Ethnicity Category. 
[image: ]
The following is the Ethnic Background to Ethnic Group Cross Walk as of 9/14/2021.The Ethnic Group information is pulled directly from the records tables.  Selecting the look up tool will enable users to see if any new Ethnic Groups have been added. This should be reviewed each year to verify Records staff have not added additional categories.

	Ethnicity Category
	Ethnic Group
	Description

	Black/African American
	AFRAM
	African American

	American Indian/Alaska Native
	ALASKN
	Alaska Native

	American Indian/Alaska Native
	ALATHAB
	Alaskan Athabaskans

	American Indian/Alaska Native
	ALEUT
	Aleutian

	American Indian/Alaska Native
	AMIND
	American Indian

	American Indian/Alaska Native
	APACHE
	Apache

	Hispanic/Latino
	ARGEN
	Argentinian

	Asian
	ASIAN
	Asian

	Asian
	ASINDIAN
	Asian Indian

	American Indian/Alaska Native
	BANNOCK
	Bannock

	Black/African American
	BLACK
	Black/African American

	American Indian/Alaska Native
	BLKFOOT
	Blackfoot

	Asian
	CAMBOD
	Cambodian

	Hispanic/Latino
	CENTAMER
	Central American

	American Indian/Alaska Native
	CHEHALIS
	Chehalis

	American Indian/Alaska Native
	CHEROK
	Cherokee

	American Indian/Alaska Native
	CHEYEN
	Cheyenne

	Hispanic/Latino
	CHICAN
	Chicana/Chicano/Chicanx

	American Indian/Alaska Native
	CHICHSA
	Chickasaw

	Hispanic/Latino
	CHILE
	Chilean

	Asian
	CHINESE
	Chinese

	American Indian/Alaska Native
	CHIPPEW
	Chippewa

	American Indian/Alaska Native
	CHOCTAW
	Choctaw

	American Indian/Alaska Native
	COEUR
	Coeur d Alene Tribe

	Hispanic/Latino
	COLOMB
	Colombian

	American Indian/Alaska Native
	COLVILLE
	COLVILLE

	American Indian/Alaska Native
	COMANCH
	Comanche

	Hispanic/Latino
	COSTAR
	Costa Rican

	American Indian/Alaska Native
	COWLITZ
	COWLITZ

	American Indian/Alaska Native
	CREE
	Cree

	American Indian/Alaska Native
	CREEK
	Creek

	American Indian/Alaska Native
	CROW
	Crow

	Hispanic/Latino
	CUBAN
	Cuban

	American Indian/Alaska Native
	DELAWA
	Delaware

	Hispanic/Latino
	DOMIN
	Dominican

	Hispanic/Latino
	ECUAT
	Ecuadorian

	Hispanic/Latino
	ELSALVA
	El Salvadorian

	American Indian/Alaska Native
	ESKIMO
	Eskimo

	Hispanic/Latino
	GALAP
	Galapagos Islander

	American Indian/Alaska Native
	GRANDRON
	Confederated Tribes of the Grand Ronde

	Hispanic/Latino
	GUAJIR
	Guajira/Guajiro/Guajirx

	Native Hawaiian/Oth Pac Island
	GUAMCHAM
	Guamanian/Chamorro

	Hispanic/Latino
	GUATEM
	Guatemalan

	Native Hawaiian/Oth Pac Island
	HAWAIIA
	Hawaiian

	Hispanic/Latino
	HISPA
	Hispanic

	Asian
	HMONG
	Hmong

	American Indian/Alaska Native
	HOH
	HOH

	Hispanic/Latino
	HONDUR
	Honduran

	American Indian/Alaska Native
	HOPI
	Hopi

	American Indian/Alaska Native
	IROQUI
	Iroquois

	American Indian/Alaska Native
	JAMESTOW
	JAMESTOWN

	Asian
	JAPANES
	Japanese

	American Indian/Alaska Native
	KALISPEL
	KALISPEL

	American Indian/Alaska Native
	KIOWA
	Kiowa

	American Indian/Alaska Native
	KLAMATH
	KLAMATH

	American Indian/Alaska Native
	KOOTENAI
	KOOTENAI

	Asian
	KOREAN
	Korean

	Asian
	LAOTIAN
	Laotian

	Hispanic/Latino
	LARAZA
	La Raza

	Hispanic/Latino
	LATINO
	Latina/Latino/Latinx

	American Indian/Alaska Native
	LOWER
	Lower Elwha Klallam Tribe

	American Indian/Alaska Native
	LUMBEE
	Lumbee

	American Indian/Alaska Native
	LUMMI
	LUMMI

	American Indian/Alaska Native
	MAKAH
	MAKAH

	Hispanic/Latino
	MESITIZ
	Mestiza/Mestizo/Mestizx

	Hispanic/Latino
	MEXAMER
	Mexican-Amer, Mexican

	Asian
	MIENH
	Mienh

	Hispanic/Latino
	MORENA
	Morena

	American Indian/Alaska Native
	MUCKLESH
	MUCKLESHOOT

	American Indian/Alaska Native
	NAVAJO
	Navajo

	American Indian/Alaska Native
	NEZPERCE
	Nez Perce Tribe

	Hispanic/Latino
	NICARAG
	Nicaraguan

	American Indian/Alaska Native
	NISQUALL
	NISQUALLY

	American Indian/Alaska Native
	NOOKSACK
	NOOKSACK

	Not Specified
	NSPEC
	Not Specified

	Hispanic/Latino
	NUEVOMEX
	Nuevo Mexicano

	American Indian/Alaska Native
	OSAGE
	Osage

	Asian
	OTHER
	Other - Asian

	Hispanic/Latino
	OTHR
	Other - Hispanic

	Native Hawaiian/Oth Pac Island
	PACIF
	Other Pacific Islander

	American Indian/Alaska Native
	PAIUTE
	Paiute

	Hispanic/Latino
	PANAMA
	Panamanian

	Hispanic/Latino
	PARAGU
	Paraguayan

	Hispanic/Latino
	PERU
	Peruvian

	Asian
	PHILIPI
	Filipino

	American Indian/Alaska Native
	PIMA
	Pima

	American Indian/Alaska Native
	PORTGAMB
	Port Gamble SKlallam Tribe

	American Indian/Alaska Native
	POTAWA
	Potawatomi

	American Indian/Alaska Native
	PSSALISH
	Puget Sound Salish

	American Indian/Alaska Native
	PUEBLO
	Pueblo

	Hispanic/Latino
	PUERTOR
	Puerto Rican

	American Indian/Alaska Native
	PUYALLUP
	PUYALLUP

	American Indian/Alaska Native
	QUILEUTE
	QUILEUTE

	American Indian/Alaska Native
	QUINAULT
	QUINAULT

	American Indian/Alaska Native
	SALISHKO
	Confederated Salish & Kootenai Tribes

	American Indian/Alaska Native
	SAMISH
	SAMISH

	Native Hawaiian/Oth Pac Island
	SAMOAN
	Samoan

	American Indian/Alaska Native
	SAUKSUIA
	Sauk Suiattle Indian Tribe

	American Indian/Alaska Native
	SEMINO
	Seminole

	American Indian/Alaska Native
	SHOALWAT
	Shoalwater Bay Indian Tribe

	American Indian/Alaska Native
	SHOSHO
	Shoshone

	American Indian/Alaska Native
	SHOSHONE
	SHOSHONE

	American Indian/Alaska Native
	SILETZ
	SILETZ

	American Indian/Alaska Native
	SIOUX
	Sioux

	American Indian/Alaska Native
	SKOKOMIS
	SKOKOMISH

	American Indian/Alaska Native
	SNOQUALM
	SNOQUALMIE

	Hispanic/Latino
	SOAMER
	South American

	Hispanic/Latino
	SPANAM
	Spanish-American

	Hispanic/Latino
	SPANISH
	Spanish

	Hispanic/Latino
	SPANMEX
	Spanish-Mexican

	American Indian/Alaska Native
	SPOKANE
	SPOKANE

	American Indian/Alaska Native
	SQUAXIN
	SQUAXIN ISLAND

	American Indian/Alaska Native
	STILLAGU
	STILLAGUAMISH

	Hispanic/Latino
	SUDAMER
	Sudamericana/Sudamericano/Sudamericanx

	American Indian/Alaska Native
	SUQUAMIS
	Suquamish Tribe

	American Indian/Alaska Native
	SWINOMIS
	SWINOMISH

	Hispanic/Latino
	TEJANO
	Tejano

	Asian
	THAI
	Thai

	American Indian/Alaska Native
	TLINGIT
	Tlingit

	American Indian/Alaska Native
	TOHONO
	Tohono O'Odham

	American Indian/Alaska Native
	TULALIP
	TULALIP

	American Indian/Alaska Native
	UMATILLA
	UMATILLA

	American Indian/Alaska Native
	UPPERSKA
	Upper Skagit Indian Tribe

	Hispanic/Latino
	URUGUAY
	Uruguayan

	Hispanic/Latino
	VENEZUEL
	Venezuelan

	Asian
	VIETNAME
	Vietnamese

	American Indian/Alaska Native
	WARMSPRI
	Confederated Tribes of Warm Springs

	White
	WHITE
	White

	American Indian/Alaska Native
	YAKAMA
	Confederated Tribes and Bands of the Yakama Nation

	American Indian/Alaska Native
	YAQUI
	Yaqui



[bookmark: _Toc107938106]Awards Config tab:
3. Select the appropriate existing FA Item Type for the Unit Record Report Award Category. Only FA Item Types that need to be reported to WSAC should be included in setup.  As an example, you should not be configuring the Work Study Offer and WCG Waitlist on this page since they are not real funds awarded to the student. (Use the worksheet in Appendix A to categorize the FA Item Types to assist with setup.)
4. Select the appropriate existing Award Status based on how you award the FA Item Type to students. The status associated with the FA Item Type is the field for which the dollar amount will be pulled from for the student and reported in the CSV data extract file. As an example, Direct Loan item types should have an award status of ‘Disbursed’, whereas the State Work Study Off Campus item type would have an award status of ‘Accepted’.
Please note – Users cannot enter values in Awards Config. fields that do not exist. 
5. Once all values are configured, select the Save button.
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[bookmark: _Toc107938107]Unit Record Report Process
The PeopleSoft Unit Record Report allows colleges to generate a .CSV data extract file along with several reports to assist with data review and data cleanup.  To run the Unit Record Report process, follow the instructions below.
Navigation: Nav Bar > Navigator > Financial Aid > CTC Custom > CTC Reports > State FA Reporting
Enter existing or new Run Control ID
Select the Add button
[image: ]
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1. Enter Institution
2. Enter Aid Year
3. Enter File Path: /CSTRANSFER/WAxxx/WCGyyyy/(where xxx represents your numeric college code, ex: 172, and yyyy represents the aid year, ex: 2022)
Report Type is not applicable for the Unit Record Report since the CSV file and supplemental reports are automatically generated in specific formats.
4. Select the Run button
[image: ]
5. At the Process Scheduler Request page, mark the checkbox for the Unit Record Report Process
6. Select the OK button

[image: ]
Back at the State FA Reporting run parameters page, verify that a Process Instance Number was assigned to your task.
Select the Process Monitor hyperlink
[image: ]
On the Process Monitor page, ensure that the Unit Record Report process (CTC_URR_AE) completes. The Run Status should say ‘Success’ and the Distribution Status say ‘Posted’.
Select the Details link to verify the process completed successfully and to access the CSV data file.
[image: ]
Select the Message Log link on the Process Detail page.
[image: ]
The following message should display to indicate the process completed successfully.
[image: ]



Select the View Log/Trace link to access the CSV data extract file.
[image: ]
On the View Log/Trace page, select the Unit_Record_Report_xxxxxx.csv link (where xxxxx represents the Process Instance Number associated with the process that was just run).

[image: ]
Depending on your browser, you may have a pop-up window providing you with the option to open or save the CSV file.
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[bookmark: _Toc107938108]Unit Record Report – Supplemental Reports

It is recommended that the reports are reviewed and worked in the order listed below. This ensures that setup and errors are addressed prior to reviewing data to be included in the URR extract file.

Report C (CTCFAURR_C) – Missing Item Type Report
This report will identify any FA Item Type that has been awarded to a student with an amount greater than zero and qualifies to be reported in the Unit Record Report extract file, but the item type does not exist in the Unit Record Report Config setup page.
Report B (CTCFAURR_B) – Error Detail and Summary Report
This sample report is separated into 2 sections: 
The first tab contains a list of students, sorted by Last Name, First Name, then EmplID, who have one or more errors. The error message number and description are included.
The second tab contains a list of all error messages encountered on the first tab with a total student count for each.
See Appendix B for suggestions on resolving each error condition.
Report A (CTCFAURR_A) – Student-detailed report. 
This report provides a list of student details to be included in the extract file. In addition, the dollar amounts for each award received by the student is tallied and provided in the total columns.

To access the reports, select the Report Manager link on the State FA Reporting run control parameters page. 
[image: ]

On the Reports page, it is recommended that Report C (CTCFAURR_C) is reviewed first to identify whether there are FA Item Types not configured in the URR setup for awards that should be reported to WSAC.
If there are FA Item Types that should be configured, please refer to the setup instructions under the Unit Record Report Configuration > Award Config tab section of this document.
Once the FA Item Types are correctly configured, you should rerun the Unit Record Report process prior to reviewing the CSV data extract file, Report A (CTCFAURR_A) or Report B (CTCFAURR_B).
When you are ready to review Report A and Report B, select the Report A (CTCFAURR_A) link and Report B (CTCFAURR_B) link.

[image: C:\Users\DENGLE~1\AppData\Local\Temp\SNAGHTML45175517.PNG]

For Report C, from the File List page select the file link that ends in .xlsx (ex:WA130_URR_Missing_Item_Types_73645525_07 05 2022.xlsx).

[image: C:\Users\DENGLE~1\AppData\Local\Temp\SNAGHTML45184582.PNG]
For Report B, select the file link that ends in .xlsx 
(ex: WA130_URR_Error_Report_73652252_07 05 2022.xlsx).	
[image: C:\Users\DENGLE~1\AppData\Local\Temp\SNAGHTML4518f4ec.PNG]

For Report A, select the file link that ends in .xlsx 
 (ex: WA130_URR_Details_73645525_07 05 2022.xlsx).
[image: C:\Users\DENGLE~1\AppData\Local\Temp\SNAGHTML4519af53.PNG]













[bookmark: _Toc107938109]Appendix A: FA Item Type Worksheet for URR Config

In review of the FA Item Type Config page, if the Award Category is no longer valid[footnoteRef:3], remove the row. [3: 1 New Award Category, WSOSGradScholarship] 

If the Award Category has been newly created[footnoteRef:4], update award category field for applicable item-type(s). [4: ] 

	[bookmark: Award_Code_Worksheet_for_URR_Table_Setup][bookmark: bookmark0]Financial Aid Program
	FA Item Type(s)
	URR Awards Config
	URR Category

	Alternative Routes to Teaching Certification
	
	ALTERNATIVEROUTES
	Alternative Routes

	College Bound Scholarship
	
	COLLEGEBOUNDSCHOLARSHIP
	College Bound Scholarship

	Other conditional loans not reported elsewhere
	
	[bookmark: RESULT0$1]CONDITIONALLOANS
	Conditional Loans

	Federal Direct/Stafford Subsidized Loans
	
	FEDERALDIRECTSUBSIDIZEDLOANS
	Federal Direct Subsidized Loans

	Federal Direct/Stafford Unsubsidized  Loans
	
	FEDERALDIRECTUNSUBSIDIZEDLOANS
	Federal Direct Unsubsidized Loans

	Federal Parent PLUS Loan
	
	FEDERALPARENTPLUSLOANS
	Federal Parent PLUS Loans

	Pell Grant
	
	FEDERALPELLGRANT
	Federal Pell Grant

	Perkins Loan
	
	FEDERALPERKINSLOAN
	Federal Perkins Loan

	SEOG
	
	FEDERALSEOG
	Federal SEOG

	Federal Nursing Student Loan and health professions student loan funds
	
	FEDERALNURSINGHEALTHLOANS
	Federal Nursing Health Loans

	Federal nursing and other health professional training scholarships and grants
	
	FEDERALNURSINGSCHOLARSHIPS
	Federal Nursing Scholarships

	Federal TEACH Grant
	
	FEDERALTEACHGRANT
	Federal TEACH Grant

	Federal Work Study
	
	FEDERALWORKSTUDY
	Federal Work Study

	Work First Work Study
Non-Work Study Institutional and Off-Campus Employment
Institutional aid fund  used as Work Study
	
	INSTITUTIONALEMPLOYMENT
	Institutional Employment

	Institutional Loans
	
	INSTITUTIONALLOANS
	Institutional Loans

	National Guard Grant
	
	NATIONALGUARDGRANT
	NationalGuardGrant

	3.5% Waivers 
Athletic Waivers (need-based) Graduate Tuition Waivers (need-based)
Institutional Aid Fund (need-based) 
Institutional grants and scholarships (need-based) Need-Based Institutional Gift Aid Need-Based Tuition & Fee Waivers 
Nonresident Enrollment Incentive Waiver (need-based) 
Tuition & Fee Waivers (need-based) 
Western Undergraduate Exchange Waiver (need-based)
	
	NEEDBASEDINSTITUTIONALGIFTAID
	Need-Based Institutional Gift Aid

	Athletic Waivers (non-need based)
Graduation Tuition Waivers (non-need based)
Institutional Aid Fund (non-need based)
Institutional grants and scholarships (non-need based)
Non-Need Based Institutional Gift Aid
Nonresident Enrollment Incentive Waiver (non-need based)
Tuition & Fee Waiver (non-need based)
Western Undergraduate Exchange Waiver (non-need based)

	
	NONNEEDBASEDINSTITUTIONGIFTAID
	Non-Need Based Institutional Gift Aid

	Off-Campus State Work Study
	
	OFFCAMPUSSTATEWORKSTUDY
	Off-Campus State Work Study

	On-Campus State Work Study
	
	ONCAMPUSSTATEWORKSTUDY
	On-Campus State Work Study

	AmeriCorp
Bureau of Indian Affairs (BIA) Scholarship, Federal scholarships for TRIO students, L & I Assistance,  
ROTC Scholarships,  
Services for the Blind Assistance, Vocational Rehab Assistance 
(DVR), Workforce Investment Act Asst.,  Other Agency Assistance
	
	OTHERAGENCYASSISTANCE
	Other Agency Assistance

	Alaska Student Loan Canadian Student Loan Micronesian Student Loan Other Loans not reported elsewhere
	
	OTHERLOANS
	Other Loans

	Early Achievers Opportunity Grant 
Washington Award for Vocational Excellence (WAVE) Washington Scholars American Indian Endowed Scholarships 
GEAR-UP 
All Other State-Funded Gift Asst.
Student Teaching Grant
Student Teaching Residency Grant
	
	OTHERSTATEFUNDEDGIFTASSISTANCE
	Other State Funded Gift Assistance

	Company Scholarships Employer Funded Tuition Assistance 
Governor’s Scholarship Leadership 1000 Scholarship National Merit Scholarships Organizational Scholarships Other state scholarships 
(i.e.,Oregon)
Outside Scholarships Private Scholarships Robert C. Byrd Honors Scholarship 
Service Club Scholarships Washington State Achievers Scholarship
	
	OUTSIDESCHOLARSHIPS
	Outside Scholarships

	Paraeducator, Pipeline for Paraeducators
	
	PARAEDUCATOR
	Paraeducator

	Passport to College Scholarship
	
	PASSPORTTOCOLLEGESCHOLARSHIP
	Passport to College Scholarship

	Passport to College Incentive Grant 

	
	PASSPORTTOCOLLEGEINCENTIVEGRNT
	Passport to College Incentive Grant 

	PREP Loan 
Other Private Loans
	
	PRIVATELOANS
	Private Loans

	List the award codes used for SBCTC Opportunity Grant  
	
	SBCTCOPPORTUNITYGRANT
	SBCTC Opportunity Grant

	Student Teaching Grant / Teacher Grant Programs 
	
	TEACHERGRANTPROGRAMS
	Teacher Grant Programs 


	Teacher Shortage Conditional Scholarship
	
	TEACHERSHORTAGECONDITIONALSCHO
	Teacher Shortage Conditional Scholarship

	Veteran’s Benefits, Veteran’s Benefits, Veteran’s Waivers,
Do NOT include Chapter 31 or 33
	
	VABENEFIT
	VA Benefit 

	WA College Grant,
WCG Apprenticeship,
Do NOT include Gear-Up here
	
	WACOLLEGEGRANT
	WA College Grant

	College Success Foundation Opportunity Scholarship (previously with CSF; now with Washington STEM/WSOS) 
Opportunity Scholarship (from Washington STEM/WSOS) 
Washington State Opportunity Scholarship (from Washington STEM/WSOS) 
Washington State Opportunity Scholarship BA Scholarship 
WSOS BA Scholarship 
	
	WSOSBASCHOLARSHIP
	WSOS BA Scholarship

	Washington State Opportunity Scholarship Career and Technical Scholarship 
WSOS Career and Technical Scholarship 
	
	WSOSCAREERTECH
	WSOS Career Tech Scholarship 


	Washington State Opportunity Scholarship Graduate Scholarship (Washington STEM/WSOS) 
	
	WSOSGRADSCHOLARSHIP
	WSOS Grad Scholarship 


	Work-based Learning Tuition Assistance Funds
Worker Retraining
Workforce Training Program
Basic Food Employment & Training (BFET)
	
	WORKFORCETRAININGFUNDS
	WorkForce Training Funds



[bookmark: _Toc107938110]Appendix B: Record File Layout and Data Source

	Field/Column Header Name
	Valid Inputs
	Remarks
	Data Source

	IsDelete
	‘N’ or “No” or ‘false’ 
‘Y’ or “Yes’ or ‘True 
May leave blank 
	Default is ‘N,’ ‘No,’ ‘false,’ or leave blank. Entry of ‘Y,’ ‘Yes,’ or ‘true’ will delete student record(s)
	N/A

	[bookmark: SSN2]SSN
	Numbers, with or without hyphens, no spaces

	Required for all recipients. Nine-digit SSN. Include leading zeros, if necessary, to fill all nine digits. For students reported in the Final Interim Report: Report the same number that was reported in the Final Interim Report. For students not reported in the Final Interim Report: Report the same number used in your institutional reporting.
	Bio-Demo if available, otherwise pull from FAFSA.

	[bookmark: InstitutionStudentID2]InstitutionStudentID
	Any characters (up to 50) 
	Community and Technical Colleges (CTCs): Use the 9-character, college-assigned student identification number (SID) as the first 9 characters (include leading zeroes). You may add additional characters up to 50 characters. This field is required for public institutions but is overrideable. EMPLID
	Bio-Demo

	[bookmark: LastName2]LastName
	Any characters (up to 100)

	Required for all recipients. If a student only has a first name, report that name as first name and last name.
	Bio-Demo

	[bookmark: FirstName2]FirstName
	Any characters (up to 50)
	Required for all recipients.
	Bio-Demo

	[bookmark: MiddleName2]MiddleName
	Any characters (up to 50)
	Optional, but provide if available.
	Bio-Demo

	[bookmark: DateOfBirth2]DateOfBirth
	Most standard US database date-only outputs are supported e.g.:
· 12/1/1987
· Dec 10 1990
· 12 Aug 1994
· ‘April 1, 1992’
· ‘1 May, 1990’
	Required field if reporting FAFSA-based or WASFA aid types; otherwise optional and may be left blank. Standard US dates. Two digit years will be accepted, but four digit years are preferred. If commas are included in the dates, enclose the data in quotes.
	Bio-Demo

	[bookmark: Gender2]Gender
	'1' or 'Male'
'2' or 'Female'
‘3’ or ‘Unknown’
‘4’ or ‘X/Non-binary’
	Required for all recipients.

	Bio-Demo

	[bookmark: IsStateResident2]IsStateResident
	‘y’ or ‘true’
‘n’ or ‘false’
	Required for all recipients.
	Bio-Demo

	[bookmark: YearInSchool2]YearInSchool
	‘1’ or ‘Freshman/1st Year’
‘2’ or ‘Sophomore/2nd Year’
‘3’ or ‘Junior/3rd Year’
4’ or ‘Senior/4th Year’
‘5’ or ‘Unclassified/5th Year’
‘6’ or ‘Graduate’
‘7’ or ‘Professional’
‘8’ or ‘Other’
	Required for all recipients. Report the status as of the beginning of the term of the recipient’s last financial aid disbursement for the year.
From legacy: Students who answer ‘Yes’ on FAFSA Question #28 should be reported with a value of ‘5’.
	[bookmark: YearInSchool4]Student Record for values 1, 2, 3 or 4.


	[bookmark: IsOfHispanicOrigin2]IsOfHispanicOrigin
	‘y’ or ‘true’ 
‘n’ or ‘false’
blank if not reported
	Report data if available. Leave blank only if information is not available.
	Student Record

	[bookmark: IsRaceAmericanIndianOrAlaskaNative2]IsRaceAmericanIndianAlaskaNative
	‘y’ or ‘true’ 
‘n’ or ‘false’
blank if not reported
	Report data if available. Leave blank only if information is not available. Race may be reported as ‘y’ or ‘true’ in one or more race category.
	Student Record

	[bookmark: IsRaceAsian2]IsRaceAsian
	‘y’ or ‘true’ 
‘n’ or ‘false’
blank if not reported
	Report data if available. Leave blank only if information is not available. Race may be reported as ‘y’ or ‘true’ in one or more race category.
	Student Record

	[bookmark: IsRaceBlackOrAfricanAmerican2]IsRaceBlackAfricanAmerican
	‘y’ or ‘true’ 
‘n’ or ‘false’
blank if not reported
	Report data if available. Leave blank only if information is not available. Race may be reported as ‘y’ or ‘true’ in one or more race category.
	Student Record

	[bookmark: IsRaceNativeHawaiianOrPacificIslander2]IsRaceNativeHawaiianPacificIslander
	‘y’ or ‘true’ 
‘n’ or ‘false’
blank if not reported
	Report data if available. Leave blank only if information is not available. Race may be reported as ‘y’ or ‘true’ in one or more race category.
	Student Record

	[bookmark: IsRaceWhite2]IsRaceWhite
	‘y’ or ‘true’ 
‘n’ or ‘false’
blank if not reported
	Report data if available. Leave blank only if information is not available. Race may be reported as ‘y’ or ‘true’ in one or more race category.
	Student Record

	[bookmark: IsRaceOther2]IsRaceOther
	‘y’ or ‘true’ 
‘n’ or ‘false’
blank if not reported
	Report data if available. Leave blank only if information is not available. Race may be reported as ‘y’ or ‘true’ in one or more race category.
	Student Record

	ISIRWASFATransNumber
	Integer
1 to 100
blank if no ISIR or WASFA
	Required for all recipients with a FAFSA or WASFA on file. Report transaction number used to award aid. Leave blank if no FAFSA or WASFA data available
	ISIR

	RejectedISIRWASFA
	‘y’ or ‘true’
‘n’ or ‘false’
	Required for all records. Use ‘y’ or ‘true’ if student did not file FAFSA or WASFA, or has only an invalid, rejected ISIR or WASFA. A blank will trigger an upload fail.
	ISIR

	[bookmark: MaritalStatus2]MaritalStatus
	‘1’ or ‘Unmarried’
‘2’ or ‘Married’
‘3’ or ‘Separated’
	Required for all need-based aid recipients with a FAFSA or WASFA on file. May be left blank if FAFSA or WASFA data is not available.
	ISIR

	[bookmark: IsDependent2]IsDependent
	‘y’ or ‘true’ 
‘n’ or ‘false’
	Required for all need-based aid recipients with a FAFSA or WASFA on file. May be left blank if FAFSA or WASFA data is not available.
	ISIR

	[bookmark: FamilySize2]FamilySize
	Integer > 0
1 to 20
	Required for all need-based aid recipients with a FAFSA or WASFA on file. May be left blank if FAFSA or WASFA data is not available. Matched to CSAW data.
	ISIR

	[bookmark: NumberInCollege2]NumberInCollege
	Integer > 0
1 to 20
	Required for all need-based aid recipients with a FAFSA or WASFA on file. May be left blank if FAFSA or WASFA data is not available. Matched to CSAW data.
	ISIR

	[bookmark: FamilyIncome2]FamilyIncome
	Integer between
-300000 and 600000
	Required for all need-based aid recipients with a FAFSA or WASFA on file. Leave blank if FAFSA or WASFA data is not available. Matched to CSAW data.
	ISIR

	[bookmark: CostOfAttendance2]CostOfAttendance
	Integer
0 to 250000
	Required for all need-based aid recipients with a FAFSA or WASFA on file. May be left blank if FAFSA or WASFA data is not available.  Must use full assessed tuition amount in COA calculation for SNG and CBS recipients, and when possible, for recipients of other need-based aid.
	FA

	[bookmark: ExpectedFamilyContribution2]ExpectedFamilyContribution
	Integer
0 to 250000
	Required for all need-based aid recipients with a FAFSA or WASFA on file. May be left blank if FAFSA or WASFA data is not available.  Report FM only.
	FA

	[bookmark: NeedDuration2]NeedDuration
	Integer  
1 to 12 
	Required for all need-based aid recipients with a FAFSA or WASFA on file. May be left blank if FAFSA or WASFA data is not available.
	FA

	[bookmark: NeedAmount2]NeedAmount
	Integer
0 to250000 
	Required for all need-based aid recipients with a FAFSA or WASFA on file. May be left blank if FAFSA or WASFA data is not available.
	FA


[bookmark: _Toc107938111]
Appendix C: Error Messages and Resolution
	Error Number
	Error Description
	Error criteria
	




Record navigation to view or resolve data
	Can record be included in .CSV extract file even if error condition occurs?

	001
	Invalid or Missing SSN
	Value being reported from the bio-demo record is blank or not equal to 9 digits in length
	Campus Community > Personal Information > Add/Update a Person > National ID field
	No, if null

	002
	Invalid or Missing Resident Code
	Student’s bio-demo residency value is missing or ‘Undetermined’
OR 
The value is other than ‘In State’, ‘Out of State’ or ‘International’. 
	Campus Community > Personal Information > Identification > Residency Data > Residency Official 1 tab > Residency field
	No

	003
	Marital Status is Missing
	Student’s marital status from the ISIR is missing.
	Financial Aid > Federal Application Data > Correct 20xx – 20xx ISIR records > Marital Status field
	No

	004
	Dependency Status is Missing or Invalid
	Student’s dependency status from the ISIR is neither ‘dependent’ nor ‘independent’.
	Financial Aid > Federal Application Data > Correct 20xx – 20xx ISIR records > 
	No

	005
	Not Enrolled in Any Terms
	The student’s FA Load value on all terms in FA Term is ‘N’.
	Financial Aid > Financial Aid Term > Maintain Student FA Term > Acad Level tab > Financial Aid Load field
	No

	006
	Invalid or Missing Year In School
	The student’s year in school value is missing OR not equal to:
‘1’ (freshman/1st year), 
‘2’ (sophomore/2nd year),
‘3’ (junior/3rd year),
‘4’ (senior/4th year), or
‘5’ (unclassified/5th year).

Year in School is calculated by a combination of earned units (between the ranges indicated in the URR Manual), whether or not students are matriculated into a BAA/BAS program included on FA Term, and the NSLDS Loan Year on FA Term.
	For NSLDS Loan Year: Financial Aid > Financial Aid Term > Maintain Student FA Term > Financial Aid Info tab > NSLDS Loan Year field

For Academic Program/Plan: Financial Aid > Financial Aid Term > Maintain Student FA Term > FA Term tab > Prim Prog or Acad Plan field

Earned units is being calculated by summing all earned units for courses numbered 100 or above
	No

	007
	Invalid or Missing Gender Code
	Student’s bio-demo gender value being reported is blank OR other than ‘Female’, ‘Male’, ‘Unknown’ or ‘X/Non-Binary.’
	Campus Community > Personal Information > Add/Update a Person > Gender field
	No

	008
	DOB is Missing or Out of Range
	The student’s bio-demo date of birth value is missing OR out of range.

Out of range value is less than 01/01/1944 or greater than 12/31/2004.
	Campus Community > Personal Information > Add/Update a Person > Date of Birth field
	Yes

	009
	Family Size is Missing, Too Small or Too Large
	The student’s Family size value from the ISIR is blank OR out of range.

For Dependent students, the value being reported is less than 02 or greater than 20.

For Independent students, the value being reported is less than 01 or greater than 20.
	Financial Aid > Federal Application Data > Correct 20XX– 20XX ISIR records > 

Dependent students: Parent Information tab > Number in Family field

Independent students: Student Information tab > Number in Family field
	Yes

	010
	Family Income is Missing, Negative Value or Too Large
	The student’s Family income value from the SNG Eligibility Data page is blank OR is less than -300,000 OR greater than 600,000.
	Financial Aid > CTC Custom > CTC Interfaces > State Need Grant > SNG Eligibility View > SNG Eligibility & Archive Data > SNG Eligible Data tab > SNG Income field
	No

	011
	Number in College is Missing, Too Small or Too Large
	The student’s Number in College value from the ISIR is less than 1 or greater than 20 OR greater than the Family Size value being reported.

If number in college is blank, a default value of ‘1’ will be inserted allowing the record to be included in the CSV file. The student will not appear on the Error Report B.
	Financial Aid > Federal Application Data > Correct 20XX – 20XX ISIR records > 

Dependent students: Parent Information tab > Number in College field

Independent students: Student Information tab > Number in College field
	Yes

	012
	Cost of Attendance is Missing
	The student’s Cost of Attendance value is blank OR zero.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student > Fed Year COA field
Also check if the student has a budget assigned to him/her. 
Financial Aid > Budgets > Maintain Term Budgets
	No

	013
	Need Amount is Missing, Too Small or Too Large
	The student’s Need Amount value is blank OR less than zero OR greater than $250,000.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student > Fed Need field
	No

	014
	State WS Recipient; Not State Resident
	Student has a WA State Work Study award, with an amount greater than zero, but the residency value on the Residency Data page is not equal to “In State”.
	Campus Community > Personal Information > Identification > Residency Data > Residency Official 1 tab > Residency field
	No

	015
	State Need Grant Recipient; Not State Resident
	Student has a WA State Need Grant award, with an amount greater than zero, but the residency value on the Residency Data page is not equal to “In State”.
	Campus Community > Personal Information > Identification > Residency Data > Residency Official 1 tab > Residency field
	No

	016
	College Bound Scholarship Recipient; Not State Resident
	Student has a College Bound Scholarship award, with an amount greater than zero, but the residency value on the Residency Data page is not equal to “In State”.
	Campus Community > Personal Information > Identification > Residency Data > Residency Official 1 tab > Residency field
	No

	017
	Opportunity Scholarship Recipient; Not State Resident
	Student has an Opportunity Scholarship award, with an amount greater than zero, but the residency value on the Residency Data page is not equal to “In State”.
	Campus Community > Personal Information > Identification > Residency Data > Residency Official 1 tab > Residency field
	No

	018
	Passport To College Recipient; Not State Resident
	Student has a Passport to College award, with an amount greater than zero, but the residency value on the Residency Data page is not equal to “In State”.
	Campus Community > Personal Information > Identification > Residency Data > Residency Official 1 tab > Residency field
	No

	019
	EFC is Missing, Negative Value or Too Large
	EFC value being reported is missing OR
EFC value being reported is less than zero OR EFC value being reported greater than $250,000.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student > Prorated EFC field
	No

	020
	Invalid ISIR, No Need or no Budget Information
	Student does not have a valid ISIR uploaded OR student budget information is missing OR the student’s initial Need (Cost of Attendance minus EFC) is zero.
	ISIR not loaded or invalid: Financial Aid > File Management > ISIR Import > 20XX-20XX Suspense Management

Missing student budget: Financial Aid > Budgets > Maintain Term Budgets

No Need: Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes

	021
	Pell Grant Exceeds Limit
	The total award amount being reported is greater than the annual amount of $9,143.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes

	022
	FSEOG Exceeds Limit
	The total award amount being reported is greater than the annual amount of $6,000.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes

	023
	TEACH Grant Exceeds Limit
	The total award amount being reported is greater than the annual amount of $8,000.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes

	024
	Federal Perkins Loan Exceeds Limit
	The total award amount being reported is greater than the annual amount of $0. *Program expiration in 2017-18
	Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes

	025
	Federal Direct Subsidized Loans Exceeds Limit
	The total award amount being reported is greater than the annual amount of $5,500.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes

	026
	Federal Direct Unsubsidized Loans Exceeds Limit
	The total award amount being reported is greater than the annual amount of $12,500.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes

	027
	State Need Grant Exceeds Term Limit(s)
	The award amount being reported for one term exceeds $1,543
OR
The award amount being reported for two terms exceeds $3,086
OR
The award amount being reported for three terms exceeds $4,630
OR
The award amount being reported for four terms exceeds $6,172

The quarterly maximums are determined for non-BAA/BAS recipients which also includes the annual DCA amount.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student > Disbursement link for the State Need Grant item type
	 Yes

	028
	College Bound Scholarship Exceeds Limit
	The total award amount being reported is greater than the annual amount of $15,000.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes

	029
	Passport to College Scholarship Exceeds Limit


	The total award amount being reported is greater than the annual amount of $9,500.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes

	030
	GET Ready for Math & Science Exceeds Limit
	The total award amount being reported is greater than the annual amount of $0. *No new funds have been available
	Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes

	031
	SBCTC Opportunity Grant  Exceeds Limit
	The total award amount being reported is greater than the annual amount of $10,000.
	Financial Aid > Awards > Award Processing > Assign Awards to a Student
	 Yes
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